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Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

W4
~ -

> -
N
,I

Indicates additional information and points which may be useful to know regarding a topic.

Timer (Boldface)

- Indicates a page where detailed information regarding a topic can be found.
Procedure Indicates operating methods and the order of operations.
The procedure indicated should be carried out in the order of the numbered steps.
[ (Name) ] Indicates the name of the buttons on the projector's remote control or the control panel.
Example: Esc button
"(Name)" Indicates the name of the buttons on the EasyMP Monitor or OS screens.

Example:

Select "Timer" - "Timer Settings".
Select Timer - Timer Settings.
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Tasks that can be done using EasyMP Monitor

Tasks that can be done using EasyMP Monitor e Mail notification function settings
EasyMP Monitor lets you carry out operations such as checking the
status of multiple EPSON projectors that are connected to a network and
controlling the projectors from the computer.

You can set e-mail addresses to which notifications are sent if a status
requiring attention, such as a problem, occurs with a projector that has
been registered.

Following are brief descriptions of the monitoring and control functions

¢ Sending messages to registered projectors
that can be carried out using EasyMP Monitor.

You can send JPEG files to the registered projectors at once by using

* Registering projectors for monitoring and control Message Broadcasting, which is a plug-in software for EasyMP

Projectors on the network can be searched for automatically, and you Monitor.
can then select projectors to be registered from the projectors that are To download the software and manual, visit www.epson.com, select
detected. your location, and select your product.

You can enter the IP addresses for target projectors to register them.

¢ Registered projectors can also be assigned to groups so that they can
be monitored and controlled in groups.

e Monitoring the statuses of registered projectors

The power status (ON/OFF) for projectors and problems or warnings
requiring attention can be checked visually by means of icons.

You can select groups of projectors or a single projector that you are LTI
interested in, and then check the cumulative lamp operating time or the
details of information such as input sources, problems, and warnings
for these projectors.
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e Controlling registered projectors

Projectors can be selected in groups or as single projectors, and you can [\ ) ]
then carry out operations for the selected projectors such as turning the 3
power on and off and switching their input sources.

Web control functions can be used to change the settings in the

projector's configuration menu.

If there are certain control actions which are carried out regularly at

particular times or on particular days, you can use Timer Settings to

register timer settings.




Installing EasyMP Monitor

Installing EasyMP Monitor

Operating environment

This software is compatible with computers that comply with the
following requirements.

e Operations carried out at the computer may become slow depending
on the number of projectors being managed. If this happens, use a
computer with higher specifications.

e EasyMP Monitor cannot be used in environments which do not allow
pings to be transmitted.

(013 Windows 2000 Professional SP4
Windows XP Home Edition SP2/SP3”
Windows XP Professional SP2/SP3"

Windows Vista"
(All editions except Starter Edition)

Windows Vista SP1/5P2"
(All editions except Starter Edition)

Windows 7 32 bit version
(All editions except Starter Edition)

Windows 7 64 bit version
Windows 8 32 bit version and 64 bit version
e Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium Il 233 MHz
or higher recommended)

Memory 64 MB or more (128 MB or more recommended)

capacity

Free hard disk 50 MB or more

space

Display SVGA (800 x 600) or higher resolution, 32 bit or higher
display color

*

Supports only 32 bit version of OS.

e Macintosh computers cannot be used.

Transferring the settings

If you are already using EasyMP or EMP Monitor, you can transfer the
projector settings to this version. The settings are stored as a data file
(EMP Monitor.dat). Make a copy of the EMP Monitor.dat before you
install this software. EMP Monitor.dat can be found at the following
location if the default settings were used to install the software:

e If your operating system is Windows 2000 or Windows XP

"C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver.
x.xx (Ver. x.xx represents the software version)"

e If your operating system is Windows Vista or Windows 7

"C:\Users\(User Name)\AppData\Local\VirtualStore\Program
Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx
represents the software version)"

If you cannot find the "AppData" folder, click "Start" - "Control Panel"
- "Appearance and Personalization" - "Folder Options". Select "View"
tab, and then configure the "Show hidden files, folders, and drives"
setting in "Advanced settings".
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e If your operating system is Windows 8

"C:\Users\(User Name)\AppData\Local\VirtualStore\Program
Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx
represents the software version)"

If you cannot find the "AppData"” folder, from the Start menu, click
"Control Panel" - "Appearance and Personalization” - "Folder Options".
Select "View" tab, and then configure the "Show hidden files, folders,
and drives" setting in "Advanced settings".

After installing this software, follow the instructions below before
starting EasyMP Monitor to transfer the settings.

e If your operating system is Windows 2000 or Windows XP

Overwrite the existing EMP Monitor.dat file with the copy you made.
The existing EMP Monitor.dat file is in "C:\Program Files\EPSON
Projector\EasyMP Monitor Ver.x.xx".

e If your operating system is Windows Vista, Windows 7, or Windows 8

Place the copy of the EMP Monitor.dat file in "C:\Users\(User
Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector\EasyMP Monitor Ver.x.xx".

- - The software name has been changed.
Before: EMP Monitor — After: EasyMP Monitor

If you are already using EMP Monitor, you can replace with this software.

Installing

You must have administrator authority in order to install EasyMP
Monitor.

To download the software and manual, visit www.epson.com and select
your location.

Double-click the downloaded software file to start the install program.
Follow the on-screen instructions.

If EasyMP or EMP Monitor is already installed, uninstall it before
installing this software. @ "Uninstalling EasyMP Monitor" p.47

Limitations imposed by a Windows Vista, Windows 7,
or Windows 8 environment

When using EasyMP Monitor under Windows Vista, Windows 7, or
Windows 8, note the following limitations.

¢ You must have administrator authority in order to use Register at
startup on the Environment setup screen of EasyMP
Monitor.@® "Monitoring using the system tray" p.27

o If EasyMP Monitor is installed on your computer, uninstall it before
you update the operating system to Windows Vista, Windows 7, or
Windows 8. Updating your OS without uninstalling the software may
cause a malfunction. @ "Uninstalling EasyMP Monitor" p.47

Before starting operations

Check the following points before starting up EasyMP Monitor.

e EasyMP Monitor must be installed on the computer to be used for
monitoring and control.

e The computer and the projectors must be connected to the network.

¢ Depending on the projector model, a commercially-available serial «»
TCP/IP conversion adapter and a connection cable are required in
order to use EasyMP Monitor. See your projector's User's Guide.

Make the settings for the serial «» TCP/IP conversion adapter before
connecting to the projector.
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:@3 To enable projectors to be monitored and controlled even when they are in

! standby mode’, make the following settings at the projectors. The settings
that need to be made will vary depending on the projector you are using.
See your User's Guide for more information.

e Set Standby Mode to Communication On (or Network On).
e Set Network Monitoring to On.

* When the projector's ) indicator is lit orange.
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Registering and deleting projectors for monitoring

Registering and deleting projectors for monitoring The main window will be displayed.

This operation is carried out when starting EasyMP Monitor for the first The red box area described in the screen below is referred to as
time after it has been installed and when you would like to add Grouping view.

projectors. Once a projector has been registered, the status for the

projector will be displayed automatically each time EasyMP Monitor is ) _Ox

Ele Edt Yew Tool Help

Hefresh Select all Ll)d) EMEQE\E‘E&%W%%H

started from that point onwards.

The operations to register projectors vary depending on where the
projectors are connected on the network.

e When registering a projector that is located in the same segment as the
computer in which EasyMP Monitor is installed. @ "Registering
projectors using automatic search (Searching for and registering
projectors that are located in the same segment)" p.12

e When registering projectors that are in multiple segments of the
network. @ "Setting the range of addresses to do an automatic search
and registration" p.14

Starting EasyMP Monitor

Procedure

e,

a@ Use one of the following methods to start EasyMP Monitor.
If your operating system is Windows 2000, Windows XP, Windows
Vista, or Windows 7

Click "Start" - "Programs" (or "All Programs") - "EPSON Projector”
- "EasyMP Monitor Ver.x.xx" to start EasyMP Monitor.

If your operating system is Windows 8

From the Start menu, select "EasyMP Monitor Ver.x.x.xx" to start
EasyMP Monitor.
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§§w\u.w%

%§ Click "Search".

Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.

Registering projectors using automatic search
(Searching for and registering projectors that are
located in the same Segment) If a projector does not appear in the list, use "Registration by spec-
ifying an IP address (Manual registration)". @ p.17

Procedures for automatic search

Create new projector {automatic registration)

Frojector name IP address
Procedure Projector10 192168.040
Projector1l 192168.041
p W’”%/% Projector12 192.168.0.42
{ o . o o o n "won H j
\_/ Right-click in Grouping view and select "New" - "Projector Projector!3 1921668043
= . Projectorld 192168044
1]
(automatic search)". Projectorl5 192163045
Projector16 192168046

The following Create new projector (automatic registration) win-
dow will be displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

Create new projector (automatic registration;)

[ Specify an address range and search.

Skart address

Search

End address

Edit

T

Cancel

® You can also carry out this operation by selecting New - Projector
(automatic search) from the Edit menu.

e Projectors that are using a serial «» TCP/IP conversion adapter cannot be
detected.

[ Specify an address range and search,
End address

Search Edit Cancel

Start address
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Procedures for registration

Procedure

J Select the projector(s) to be registered from the displayed
list, and then click "Edit".

The following window will be displayed.

Create new projector {(automatic search)
Display name | |
Dizplay icon
-
N =
Parent group | [Mone] j
Frojectar name | Projector1
IP address | 169 . 254 . 183 . 151 Search
r
Puort Murnber ’7
tdonitor Pagsword |
D escription
v Monitar
Regizter Cancel

Make the necessary settings while referring to the following table.

Display name

Enter the name of the projector(s) to be
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group | Select when registering a projector in a group.
If no groups have been created, this cannot be
selected.

@ "Registering several projectors to a
monitoring group all at once" p.18

Projector This shows the name that has been registered on

name the projector.

IP address This shows the IP address for the registered

projector.

Use Serial «
TCP/IP
conversion
adaptor.

This cannot be selected when registering
projectors using automatic search.

Port Number

This cannot be selected when registering
projectors using automatic search.

Monitor
Password

If a Monitor Password has been set for the
projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered.
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Description You can enter a memo about the projector. The
details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat Steps 1 and 2.

AN/
;@— Projectors that have been registered using automatic search are searched
for again by projector name each time EasyMP Monitor is started.

To end the registration operation, click E in the top-right
corner of the window or click "Cancel".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Refer to @ "Monitoring window layout" p.21 for details on using
the Grouping view and Detail list view.

Setting the range of addresses to do an automatic
search and registration

—:@:— Projectors that are using a serial «» TCP/IP conversion adapter cannot be
’ detected.

Procedures for automatic search

Procedure

S ““‘"”’%,%

s Right-click in Grouping view and select "New" - "Projector
~ (automatic search)".

The Create new projector (automatic registration) window will be
displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

72\

@ Select the "Specify an address range and search." check box
and then enter "Start address" and "End address" in the
range.

Create new projector (aukomatic registration)

Iv Epecify an address range and search.

Start address ( 192 , 168 . 0 . 00 )gd address ( 192 , 168 . 0 . 50 "
A

Edit Cancel

Search
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Click "Search".

Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.

Create new projector (automatic registration;)

Projector name IP address
Projector10 192168040
Projectord 192168041
Projector12 192168042
Projector!3 192168043
Projector1d 192165044
Projector1s 192168045
Projector16 192168046

|v Specify an address range and search.

Start address 192 ., 168 . 0 . 00 End address 192 . 168 . 0 ., 50

Search Edit Cancel
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Procedures for registration

Procedure

\_/ Select the projector(s) to be registered from the displayed
list, and then click "Edit".

The following window will be displayed.

Create new projectar {automatic search)
Display name | |
Dizplay jcon
- o
4 | 2
Parent group | [Mane) ﬂ
Praojectar hame | Projectar1O
IP address | 169 . 254 . 183 . 151 Search
-
Puort Mumber ’7
b onitor Pazsword |
D escription
IV tanitar
Register Cancel

Make the necessary settings while referring to the following table.

Display name

Enter the name of the projector(s) to be
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group | Select when registering a projector in a group.
If no groups have been created, this cannot be
selected.@®" "Registering several projectors to a
monitoring group all at once" p.18

Projector This shows the name that has been registered on

name the projector.

IP address This shows the IP address for the registered

projector.

Use Serial «
TCP/IP
conversion
adaptor.

This cannot be selected when registering
projectors using automatic search.

Port Number

This cannot be selected when registering
projectors using automatic search.

Monitor
Password

If a Monitor Password has been set for the
projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered.

Description

You can enter a memo about the projector. The
details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.
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®
\£/ After entering the details, click "Register" to start the . . €. ¢
" registration. When the message is displayed, click "OK". Registration by specifying an IP address (Manual

To continue registering other projector(s), repeat Steps 1 and 2. registration)

| To end the registration operation, click El in the top-right Procedure
corner of the window or click "Cancel".

3 | Right-click in Grouping view and select "New" - "Projector

The icon(s) of the projector(s) you registered will be displayed in (manual registration)".

Grouping view or Detail list view.

Refer to @ "Monitoring window layout" p.21 for details on using The following window will be displayed.

the Grouping view and Detail list view. If Detail list view is displayed, select New - Projector (manual reg-
istration) from the Edit menu.

Create new projectar (manual registration)

Display name [l
Display jcon
8 e <
< | 2
PFarent gioup | Nane) |
Prajectar name |
IF address | . . . Search

[ Use Seral <-» TCPAP corversion adapar,

Port Mumber

tonitor Password |

Description

[v* M anitor

Register Cancel
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;@- You can also carry out this operation by selecting New - Projector (manual

registration) from the Edit menu.

/' Enter the IP address of the projector to be registered in the

"IP address" box and then click "Search". When the message
is displayed, click "OK".
If you are using a serial +» TCP/IP conversion adapter and cable to

connect the projector, select Use Serial «» TCP/IP conversion
adaptor, enter the port number in Port Number, and then click

Search.

/ After searching is complete, enter the information for the

projector to be registered while referring to the table below.

Display name

Enter the name of the projector(s) to be displayed
in Grouping view or Detail list view.Up to a
maximum of 32 bytes can be entered. A space
cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group

Select when registering a projector in a group. If
no groups have been created, this cannot be
selected. (See the next section for more
information on registering projectors to a group.)

Projector This shows the name that has been registered on
name the projector.
IP address This shows the IP address that you entered in step

2.

Use Serial «
TCP/IP
conversion
adaptor.

Select this if you are using a serial «» TCP/IP
conversion adapter to connect the projector.

Port Number If you are using a serial «» TCP/IP conversion
adapter to connect the projector, enter the port

number.
Monitor If a Monitor Password has been set for the
Password projector, be sure to enter the Monitor Password

that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered. If you are using a serial «» TCP/IP
conversion adapter to connect the projector, the
Monitor Password security function cannot be
used.

Description You can enter a memo about the projector. The
details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

‘ ) After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Registering several projectors to a monitoring group
all at once

Projectors that have been registered can then be registered together into
different groups so that they can be monitored and controlled together.

Furthermore, if you select one of the registered groups as the Parent
group, monitoring and control operations can be carried out for all
projectors in that Parent group.
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A Parent group can be set for other parent groups, so that a hierarchical
group arrangement can be created.

First, create the registration groups, and then register projectors into the
groups that have been created.

Procedure

/ Right-click in Grouping view and select "New" - "Group".
The following window will be displayed.

Make the necessary settings while referring to the table below.

If Detail list view is displayed, select New - Group from the Edit
menu.

£
O — I
pRSp— [More) =

Reagister Cancel

Enter the name of the group to be displayed in
Grouping view or Detail list view.

Group nhame

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping
view.
Parent group | This selects the parent group. If no groups have

been created, this cannot be selected.

Monitor Select this to monitor all projectors that have
been registered in the group. If this is not
selected, the settings made when the individual

projectors were registered will be used.

It cannot be set when creating a new group.

:@:‘ You can also carry out this operation by selecting New - Group from the
! Edit menu.

/ When the setup is complete, click "Register" to start the

= registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view.

Right-click the projector icon(s) to register to the group you
have created in Grouping view or Detail list view, and select
"Editl'.

You can also carry out this operation by selecting Edit in the Edit menu.

3

§ In the Edit projector window, select the group name to use
for registering in Parent group and then click "Change".

The status of the group registration will be displayed as an icon in

Grouping view.
Al
:@: The registration details can also be checked using Projector list in the View
’ menu.
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If the projector name or IP address changes after
registration

For projectors that have been registered manually

Procedure

\_~/ Right-click on a projectoricon in Grouping view or Detail list
view and select "Monitoring disabled". Then right-click the
projector icon again and select "Edit".

;@:— You can also carry out these operations by using the Edit menu.

If only the projector name has been changed, click "Search"
in the Edit projector window that is displayed. If the IP
address has been changed, enter the new IP address in the
"IP address" box and then click "Search". When the message
is displayed, click "OK".

7/ When the display returns to the Edit projector window, click
"Change".

For projectors that have been registered using automatic
search

Procedure

’ Delete the projector(s) whose name or IP address has been
changed in Grouping view or Detail list view. (See the next
section for more information on deleting projectors.)

\</ Carry out automatic search to re-register the

projector(s).@ p.12

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer
required for monitoring or control using EasyMP Monitor.

Procedure

Right-click the icon for the projector or group that is to be deleted
in Grouping view or Detail list view and select "Delete". When the
message is displayed, click "OK".

More than one projector can be selected for deleting by selecting in
Grouping view or Detail list view.

The methods of selecting more than one projector at the same time are as
follows.

e If you select a Group icon in Grouping view, all projectors that have
been registered in that group will be deleted at the same time.

¢ Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.

L4
-

@3 You can also carry out this operation by selecting Delete in the Edit menu.
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Monitoring window layout e Detail list view
This view lets you display the status of each projector as a list so that the
projectors can be checked in detail. You can also display specific items

Types of monitoring windows and switching method as a list, and sort display items using a specific row as a sort key.
Types of monitoring windows : s . =
@ @ =
There are two types of monitoring windows. Select a desired window. 2 § —
¢ Grouping view - § ==
This view lets you check the status of group registrations in a H 1 § —
hierarchical diagram. B e S W i J

Detail list view

[ o seast |0 OO BE-pEpeE=FHEeo@Emm U
B

® How to switch views

Bt

SSSSS = = - Grouping view and Detail list view are switched as follows.

Grouping view
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Procedure

Click the View menu, and select "Grouping view" or "Detail list
view".

Monitoring using Grouping view

Meanings of Grouping view icons

In Grouping view, the patterns on the icons indicate the statuses of the
projectors. If the group icons are round in shape, it indicates that there is
another level below them. @ p.23

5

Fie Edt View Tool Help

Refish | Selectal O®h BB pEp o 2= F o milaga s

® (&)

Branch B Branch C
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The icon patterns and their meanings are explained below. Projector
€= | Network error (Monitor Password authentication error)
X : :
No warnings or problems No Monitor Password was entered when the projector was
All broiectors in the aroub are normal registered, or an incorrect Monitor Password was entered. @ p.13,
pro) group : p.16, p.17
@ Warning or problem Eﬁn Network error (TCP connection error)
A projector in the group has a warning or problem status. X
Notification @ Network error (ESC/VP.net communication error) >
?
A projector requiring immediate attention has been detected =
within the group.

. Monitoring disabled *1 When Temperature level display group view is set to On at Environment
The projector is not being monitored. If you right-click the icon and setup in the Tool menu, an icon indicating the internal temperature of the
select Monitoring enabled, the proj.ector will be added to the projector will be displayed on top of the projector icon. The default setting

roiectors that are bein ménitore d is Off. As you can get an idea of how the temperature inside the projector is
proJ 9 i increasing when Temperature level is displayed, you can make

@ Data being updated improvements to the projector's operating environment before a high

' internal temperature error or high-temperature warning occur. @ p.28

*2 Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.

Projector

. *
No warnings or problems '

Click "Refresh" in the main window to update the status.

Data being updated

) - Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.
e Warning or problem *3 Check that the projector has been correctly connected to the network.
N/
Notification ;@: The projector information that is generated when a problem is detected is
! stored until EasyMP Monitor is closed. EasyMP Monitor displays will not
. Monitoring disabled be updated automatically even if the projector status returns to normal.

Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.
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¢ Expanding and collapsing icons
Each time you double-click a group icon, the icons for the projector
that have been registered in that group are displayed or hidden.

e Moving icons
To change the position of an icon within Grouping view, simply drag
and drop the icon to be moved.

Monitoring using Detail list view

Meanings of Detail list view icons

The status of registered projectors is displayed as a list in Detail list view
regardless of which Group the projectors belong to.

Ox
Tﬁﬁt.li-ii-mgﬁw%
Fomrame— NFower | o Hou T [Frerperatue evel || e
(]
- @ 120H [T
jector2 o B0H | |
Brarch A/Showrcom/Showraom N | 3 @*R 18H EEE=s &
Branch A/Showrsom/Showrsem &, | fo2 o ™ EEE=s
Branch A7Showroom/Shawoam & | Na3 @ 28H ||
Branch A7Showroom/Shawoom B | a4 @ 20H ||
[Branch A7S howroom/Showoom B | o @ 2] ||
Branch B /Confersrce Foom o (@) 151 ==
Branch B/Cor m o1 (@) 100H ==
Branch B/Cor m [ (@) BH ==
Branch B/C [ic (@] 78H | ]
Branch B /Receplion Aoom om 1 (@] 79H | | i
Branch B /Reception Room oom 2 (@) 804 EEE=s |
bl | oy
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The icon patterns and their meanings are explained below.

O Type
Displays the projector status.
&2 No warnings or problems’’

v e Warning or problem

An error has occurred on the projector.
@ Notification

The projector requires immediate attention.
. Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to
the projectors that are being monitored.

g Data being updated
@ Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered.
@ p.13,p.16,p.17

@ Network error (TCP connection error
@ Network error (ESC/VP.net communication error

)2
)3
@ Group name

When projectors are registered to a group, the name of the group that
the projector belongs to is displayed.

© Display name
Shows the display name.
@ Power
Shows the power on status for the projector.
@ Power on and normal status @ Power off and normal status

@\ Power on and abnormal @) Power off and abnormal
status status

@® Lamp Hours

Shows the lamp operating time for the projector. If the projector has 2
lamps, it shows the lamp operating time for both lamp 1 and lamp 2.

® Temperature level

The following five icons display the differing internal temperature
status of the projector.

=" Internal temperature == |nternal temperature

normal normal

[EEE" ] High-temperature [Em=® | High-temperature
warning warning

Internal temperature
error

@ Error information
Shows a natification or warning/problem status using the following
icons.
Clean Air Filter Notice Replace Lamp #
Replace Lamp (Lamp 1) Replace Lamp (Lamp 2)
Lamp error (Lamp 1) Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)

Lamp failure at power on
(Lamp 1)

E sSeEgi

High-temperature warning Replace Air Filter

1 No Air Filter

Low Air Flow

Supply System Error (Ballast
1)

Cinema filter warning

Air Flow Sensor Err.

m
21

Supply System Error (Ballast
2)

Shutter warning

3 Hhlld Y9

5

Lamp Cover Open

Lamp Error Lamp Error (Lamp 1)

“ =

Lamp Error (Lamp 2) Lamp failure at power on

.." 5

Eea
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H . D \/7_

E Lamp failure at power on [E Lamp failure at power on :@: e The projector information that is generated when a problem is detected is
(Lamp 1) (Lamp 2) ! stored until EasyMP Monitor is closed. EasyMP Monitor displays will not

@] High internal temperature Low air flow error be updated automatically even if the projector status returns to normal.
error ' Click "Refresh” in the main window to update the status.

=% Airfilter air flow sensor error Internal Error e Detectable error information differs with the projector you are using.

Fan error [#) Sensor error

Supply System Error (8 Supply System Error (Ballast Selecting display items
(Ballast) 1)

@ Supply System Error (Ballast Auto Iris Error You can select only the required items to be displayed in Detail list view.
2)

@ Cinemafilter error @& Shutter error Procedure

(@4 Cooling system error Cooling system error

(Peltier element) [@ (pump) Select "Option" from the View menu.

Other error @ Obstacle Detection The Option window will be displayed.

Warning

Exhaust vent shuttererror  [g Easy Interactive Function
Error Dizplay items

E

Obstacle Detection Error

v Group name

*1 When Temperature level display group view is set to On at Environment B el i)

setup in the Tool menu, an icon indicating the internal temperature of the
projector will be displayed on top of the projector icon. The default setting
is Off. W [Bawer

*2 Check the following items. WV Larp Hers

v Dizplay name

[ 1P address

- Check that the projector's power is turned on. L
- Check that the LAN cable is connected. ¥ Temperature level
- Check that Standby Mode is set to Communication On (or Network On) " Desgription
or Network Monitoring is set to On in the projector's configuration menu. W Enor information
*3 Check that the projector has been correctly connected to the network. — —

*4 You can display Replace Lamp at any time by setting a preset in the
Environment setup in the Tool menu.

) Select the check box of the item you want to display.

=
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Click "OK". Procedure

/ When all of the details of the item cannot be displayed in Select "Projector list" from the View menu.
Detail list view, drag the boundary line on the right of the The following window will be displayed.
item name so that the view is extended to the desired width.

Sorting |iStS # (=) Convention Hall
@ Lobby
. . . . = [A Sh
You can sort detailed lists by using a specific row as a sort key, such as ng':m N
projector name order or IP address order. % Eo;
o,
@ Nod
Procedure ¥ (g) Showroom B
+ (&3 Branch B
Branch C
Click the item name of the row you want to use as the sort key.

With Projector list, temperature level icons are not displayed regardless

Searching for desired icons (Projector list) of the setting of Temperature level display group view at Environment

setup in the Tool menu.
The Projector list feature is useful for searching in lists when many

groups and projectors are registered and the icon you are looking for is
not displayed on screen.

The Projector list lets you check the registration details for groups in a
hierarchical diagram. When you click on an icon, Grouping view and

Detail list view are scrolled so that the selected icon is displayed in the
window.

Monitoring using the system tray

The projector statuses are always displayed as icons in the system tray,
even when Grouping view or Detail list view is not always displayed, and
the statuses can be checked by the icon patterns.
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When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

The icon patterns are explained below.

© Noproblem /A

Problem

Procedure

Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

s,

Select "Resident in the task tray".

Environment: setup

5 H minutes

Temperature level display group view @ 0Off  On

Update interval

Lamp scheduls notification @ 0ff © On

1000 3: Hour

Log output = D £ 0n

I~ Register at startup

I™ Change the application lock password

0ld password I

Mew password I

New password [confirm) [

0K Cancel

) Click "OK".

«@:‘ e Right-click the icon in the system tray to open a pop-up menu to select the
! Open the main screen or Exit.

o If Register at startup in the Environment setup is selected, EasyMP
Monitor starts automatically when the computer's power is turned on.
When using EasyMP Monitor under Windows Vista, Windows 7, or
Windows 8 you must have administrator authority in order to use this
function.

Displaying projectors with problem or warning
statuses in a list

You can display a list of only the projectors which have a problem or
warning status.

Procedure

Select "Warning and Error Projector list" from the View menu.

The following Warning and Error Projector list window will be
displayed.
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If you move the mouse pointer over the icon of the Error information,
details of the error and the remedy will be displayed. If you double-click
in a line, the properties for that projector will be displayed. @ p.32

Praojectorl @
Ne3 @
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The icon patterns and their meanings are explained below.

O Type
Shows the group or projector status.
&2 No warnings or problems’’

v e Warning or problem

An error has occurred on the projector.
@ Notification

The projector requires immediate attention.
. Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to
the projectors that are being monitored.

g Data being updated
@ Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered.
@ p.13,p.16,p.17
@ Network error (TCP connection error) 2
@ Network error (ESC/VP.net communication error)*3
@ Display name
Shows the display name.
© Power
Shows the power on status for the projector.
@ Power on and normal status @ Power off and normal status

@\ Power on and abnormal @) Power off and abnormal
status status

9 Lamp Hours
Shows the lamp operating time for the projector.
@ Source

Shows the input source that has been selected for the projector.

& @@ Computer or
QoL= Computer1

@00¢ BNC

ﬁ Video (RCA)

ﬂj SDI

DVI-D1 or HDMIT,
DVI-D, HDMI™

mm) D-Video

:& USB Display
EESR USB2

HDBaseT

HDET

® Temperature level

": :Q Computer2

5 S-Video
Video (BNQ)
DisplayPort

ﬁ DVI-D2 or HDMI2"

Irrrrr

é%; EasyMP
LS USB or USB1

(g LAN

i Whiteboard

—

The following five icons display the differing internal temperature

status of the projector.

[E"""1 Internal temperature

normal

[EEE 1 High-temperature

warning

Internal temperature

error
@ Error information

[E="" "] Internal temperature
normal

[E==E | High-temperature
warning
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Shows a warning/problem status using the following icons.

S Y9s

GHE® BEEE

.—|I
=

gk ®F 2R =

B &

Replace Lamp ®
Replace Lamp (Lamp 2)
Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)

Replace Air Filter

Low Air Flow

Supply System Error (Ballast
1)

Cinema filter warning
Lamp Cover Open

Lamp Error (Lamp 1)

Lamp failure at power on

Lamp failure at power on
(Lamp 2)

Low air flow error
Internal Error
Sensor error

Supply System Error (Ballast
1)

Auto Iris Error

Shutter error

Cooling system error
(pump)
Exhaust vent shutter error

= HEd

&

M E MeEg

gy
by

=

0 PR &

@

Replace Lamp (Lamp 1)
Lamp error (Lamp 1)

Lamp failure at power on
(Lamp 1)

High-temperature warning

No Air Filter
Air Flow Sensor Err.

Supply System Error (Ballast
2)

Shutter warning
Lamp Error
Lamp Error (Lamp 2)

Lamp failure at power on
(Lamp 1)

High internal temperature
error

Air filter air flow sensor error
Fan error

Supply System Error
(Ballast)

Supply System Error (Ballast
2)

Cinema filter error

Cooling system error
(Peltier element)

Other error

Obstacle Detectionwarning

*1

*2

*3
*4

*5

*6

Az
-~ -
— -

N

,l

Easy Interactive Function
Error

Obstacle Detection Error

When Temperature level display group view is set to On at Environment
setup in the Tool menu, an icon indicating the internal temperature of the
projector will be displayed on top of the projector icon. The default setting
is Off.

Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.

Check that the projector has been correctly connected to the network.

It describes DVI-D if the projector is equipped with both DVI-D and HDMI
input terminal.

It describes HDMI if the projector is equipped with both DVI-D and HDMI
input terminal.

You can display Replace Lamp at any time by setting a preset in the
Environment setup in the Tool menu.

Detectable error information differs with the projector you are using.

Checking properties in detail

You can check the properties of Group and projectors in detail.
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Displaying Group properties
Procedure

You can use either of the following methods to display the proper-

ties.

e Displaying the properties for all groups in Grouping view
Right-click in Grouping view and select Property.

e Displaying the specified group properties
Right-click an icon in Grouping view and then select Property.

Displaying Projector properties

Right-click on a projector icon in Grouping view or Detail list view and
select Property.

tion:  Timer

Group name
Projector name
Dizplay name
IP address

Lamp Hours

Branch &
test]

Lobby
10120224
33H

Temperature level o s
Drescription
YN L EEEE EEC e
= I Serial Nurnber X000 :
Type | Display name | Power | Lamp Hours Source | Temperatue level | Error information
“Wersion information F1 6400733057U5V050
& s - - - F2 B40040WAw050
@ . F3 E141wWB100
ComventionHe = e e e
- Error infarmation Mo signal
(@) Lobby © 3 oo =)

@ Shows the projector's serial number. If hyphens are displayed, confirm
If you double-click in a line, the properties for that group or projector the serial number on the label of the projector.

will be displayed. @ Displays the projector firmware version.

Displaying and deleting logs

In your web browser, you can check a transmission log of content such as
what has been controlled by EasyMP Monitor and projector errors. You
can delete logs once you have checked them.
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AN/
;@: When Log output is set to On at Environment setup in the Tool menu,
! transmission logs are stored. The default setting is Off.

Displaying Log
Procedure

Select "Log" - "View" from the View menu.

The web browser will open and the communication logs up until that
time will be displayed.

Deleting Log

Procedure

Select "Log" - "Delete" from the View menu. When the confirma-
tion message is displayed, click "OK".

Alllogs will be deleted and details of EasyMP Monitor control operations
and details of projector errors from that point onward will be recorded in
a new log.
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Using the control functions

Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail
list view, and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more
than one projector in Grouping view or Detail list view and clicking a
control button. The methods of selecting more than one projector at the
same time are as follows.

o If you select a group icon in Grouping view, all projectors that have been
registered in that group and that are set to be monitored can be
controlled at the same time.

¢ Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.

EE _Ox
File  Edt wiew Tool Help N

0O BE~TEBO S =HT=1= 5w

(6)

Branch B Branch C
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The following table shows the meanings of the control buttons.

o) Power On Turns the projector power on.
& Power Off Turns the projector power off.
= Switch source Switches the input source to the Computer1
oaE Computer1 port or Computer port.
Switch source Switches the input source to the Computer2
= Computer 2 port.
Switch source Switches the input source to the BNC port.
eee BNC
Switch source Switches the input source to the S-Video port.
=3 S-Video
= Switch source Switches the input source to the Video port or
Video (RCA) video2 port.
— Switch source Switches the input source to the Video1 port.
: Video (BNC)
Switch source Switches the input source to the SDI port.
@ |spi
Switch source Switches the input source to the HDBaseT
HeET HDBaseT port.
Switch source Switches the input source to the DisplayPort
— DisplayPort port.
— Switch source Switches the input source to the DVI-D1 port
=1L DVI-D, HDMI 1 or HDMI1 port.
If the projector is equipped with either a
DVI-D port or HDMI port, use this button to
switch the input signal.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
DVI-D as an input source.

Switch source

Switches the input source to the DVI-D2 port

& | DVI-D,HDMI2 |or HDMI2 port.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
HDMI as an input source.
Switch source Switches the input source to the D4 port.
D-Video
Switch source Switches the input source to EasyMP or
= EasyMP EasyMP.net.
Switch source Switches the input source to USB Display.
= . *
== USB Display
Switch source Switches the input source to the external
L USB1" equipment connected via a USB (Type A) port
or USB1.
Switch source Switches the input source to the external
H | usB2 equipment connected via a USB2 port.

%

Switch source
LAN"

Switches the input source to the image
projected by the computer via a network.

=

Switch source
Whiteboard

Switches the input source to Whiteboard.

*

If the button does not function, you can switch the input source using the
button.

e Some connected projectors may not be equipped with all of the above ports
or functions. If you click a button for a port or function that is not
available, nothing will happen.
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® You can select objects to be controlled and use the control buttons to carry
out control operations even when the following are being displayed.

Group properties @ p.32
Projector properties @ p.32

Warning and Error Projector list
(Control operations can only be carried out for projectors with a warning

status.) @ p.28

Carrying out control using a web browser (Web
control)

You can use the computer's web browser to change the configuration
menu settings for projectors.

Procedure

Right-click on the icon of a projector to be controlled in
Grouping view or Detail list view and select "Web control".

The web browser will open and the Web control window will
be displayed.

Web control lets you set the same details as the configuration menu for
the projector. See your User’s Guide for more information.

A\l

:@:— You can select projectors and right-click on them to select Web control
’ even when the following are being displayed.
Group properties @ p.32

Warning and Error Projector list (Control operations can only be carried
out for projectors with a warning status.) @ p.28

Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning
a projector's power on and off at specified times every day or every week.

Timer settings can be carried out either for a single projector only, or all
at once for all projectors in a group.

Procedure

Select "Timer" - "Timer Settings" from the Tool menu.

The following window will be displayed and you can then check the timer
setting status.

Projectors Date
= Iii Eranch A Al 04/2009 4
=, C tion Hall
e SUN | MON | TUE | WED | THU | FAI | SAT
= I shoroom | [ 1 2 |3 |4
= 15, showroom & 5 A E i 1
@D Mol 12 13 14 15 16 17 18
& Noz 19 20 21 22 23 24 25
@ No3 26 27 28 249 30
=| & Showroom B
@) Mo
@ Mos Timers
3 Branch B
+ 4 Branch ¢ Display name Date Time (24 hour) | Operation
@ Labby 4/7/2000 18:43 Computer2
2. Showroom B 4i7 /2009 18:45 Pawer ON
[ ] 4f7/2009 18:59 Power Oh
&, Showroom & 417/2009 18:59 Power ON
[< | >
I Enabled Digabled I Add Edit Delete O
[ I Close o |
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The details that can be checked and operations that can be carried out at 0 Edit

this time are given below. £ Lets you change the timer settings that have been

@ Projectors selected from the timer list. If a group has been selected
for status checking, the settings cannot be changed.
@ Add

When a group is selected, the timer setting statuses for all projectors ac
in that group are displayed. = Registers new timer settings. (See the next section for

@ Date more information.)
© Enabled/disabled

Enabled

Selects a group or projector to check the status of.

Shows the current day in a red box.
Switches the timer settings that have been selected from

Days for which timer settings have been made are shown in bold. veses the timer list between Enabled and Disabled.

Click | or * | to switch to the calendar for the previous or next
month.

© Timers
Shows a list of the timer settings.
The line colors in the Timers list have the following meanings:

LI Current day's timer
setting

LI When some of the projectors in the group have timer
setting enabled and others have it disabled for the
current day's timer setting

| | When the current day's timer setting is a disabled setting
B Timer setting for a day other than the current day
@ Delete

Delete

Lets you delete timer settings that have been selected
from the timer list.

@ Close

tes= . Closes the Timer Settings window.
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Procedures for new timer settings :@: You can enable and disable all of the timer settings that have been
registered. Select Timer - Enable or Disable from the Tool menu.

Procedure

Create Mew Timer
Schedue mode -
Date |2009IU4I14 j
Time [24 hour] |19:u4 =
Operation |P0wer o] j
0. Cancel

At Operation, you can carry out the operations of turning the pow-
er on and off and switching the input sources, similarly for the con-
trol buttons on the main window. If you set the input source
switching, the projector's power will turn on at the timer start time
even if it is not on at the time. Because of this, it is not necessary to
make two separate timer settings for turning the power on and
switching the input source.

"/ After completing the timer settings, click "OK".

The timer settings that have been made will be registered and they
can be checked in the displayed timer list.
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Mail notification function settings

The mail notification function can be used to send corresponding
notification messages to a preset e-mail address when a projector that is
connected to the network assumes a certain status, or if it experiences a
problem or warning. By using this function, the operator can be notified
of a projector’s status or problems even when the operator is in a
different location from the projectors.

:@3 o Up to three addressees (destinations) can be registered and messages can be
! sent to all of them at once.

e If a critical problem develops with a projector which causes it to suddenly
stop working, it may not be possible for the projector to send a message
notifying an operator of the problem.

o If Standby Mode is set to Communication On (or Network On) or Network
Monitoring is set to On in the projector configuration menus, you can
monitor the projector even when it is in standby mode (when its power is
turned off). See your User's Guide for more information.

e On some projectors, the mail notification function can be set in the
configuration menu. When notification messages are set to be sent in the
projector’s configuration menu, both the settings in the configuration menu
and settings made on EasyMP Monitor are functional.

e Detectable status with the mail notification function differs with the
projector you are using.

Procedure

J Select "Mail notification function" from the Tool menu.

Mail natification function

SMTP server IP address

Sender mail address

Recipient mail address 1

Recipient mail address 2

Recipient mail address 3

“ i “ on

Part Mumber 25

Motification event

|
|
| Motification gvent
|
|

notification event

oK Cancel

Make the necessary settings while referring to the table below.

Mail notification

Set to On to use the mail notification function.

function
SMTP server IP Enter the IP address of the SMTP server. Up to
address a maximum of 255 bytes can be entered.

When you change a port number of the SMTP
server, specify this port number. The default
value is "25".

You can enter a valid number from 1 to 65535.

Sender mail
address

Enter the sender's e-mail address. Up to a
maximum of 255 bytes can be entered.

Recipient mail
address 1

Recipient mail
address 2

Recipient mail
address 3

Specify the destination addresses for the
notification e-mail. Up to three destinations
can be set. Up to a maximum of 255 bytes can
be entered.
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Click "Notification event" and check the items for mail
notification in the window that appears.

Set notification event

1>

Lamp
¥ Replace Lamp
v Lamp failure at power on
¥ Larmp Cover Open
v Larmp Emor

Air Filker

[W Clean Air Filter Natice
W Ma air Filter 4

W Lo Air Flow

¥ Replace Air Filter

¥ 2ir Flow Sensar Err.

W Air filter air flowe sensor emar

¥ Low air flowe error

Metwark.
[ Metwark eror [TCP connection eror)
[T Metwork eror [ESCAYP.net communication error)

™ Metwork eror [monitor password authentication erar]

|£

Cancel

Click "OK".

The Set mail notification function window appears again.

Repeat Steps 3 and 4 to set the notification events for the other
email addresses.

y@% . o ] n
/' When the setup is complete, click "OK".
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An e-mail notifying the operator of a problem/warning/status is issued
If the projector experiences a problem or enters a status requiring
attention, an e-mail like that shown below is sent to the address specified
for Recipient mail address.

If there is more than one problem, warning, or status, the corresponding
messages are output to separate lines.

Item Details shown

E-mail subject [Display name displayed in Grouping view or Detail
list view] Projector status notification

Body <Display name displayed in Grouping view or Detail
list view> has entered the following status.

<Warning/error/status message> (Please see the
next table)




An e-mail notifying the operator of a problem/warning/status is issued

The details contained in the e-mail message can consist of the following.

Message

Remedy

Message

Remedy

Easy Interactive
Function Error

Internal Error

Fan error

Sensor error

Stop using the projector, disconnect the power

cable from the electrical outlet, and contact Epson.

See your User's Guide for more information.

High-temperature
warning

Replace Lamp”

Supply éystem Error
(Ballast)

Replace Air Filter

Lamp Cover Open

Lamp failure at power
on

Lamp Error’

See your User's Guide for more information.

No Air Filter

Low Air Flow

Air Flow Sensor Err.

Cinema filter warning

Supply éystem Error
(Ballast)

High internal
temperature error

Low air flow error

Air filter air flow
sensor error

Cinema filter error

Shutter error

Cooling system error
(Peltier element)

Cooling system error
(pump)

Auto Iris Error

Stop using the projector, disconnect the power

cable from the electrical outlet, and contact Epson.

See your User's Guide for more information

Shutter warning

Clean Air Filter Notice

Exhaust vent shutter
error

Obstacle Detection
Error

Obstacle Detection
Warning

Low air flow error

High internal
temperature error

Other warning

Other error

See your User's Guide for more information.

No signal

No image signals are being received by the
projector. Check the connection status and check
that the power for the connected equipment is
turned on.
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Message Remedy

Network error (TCP Check the following items.

connection error) Check that the projector's power is turned on.

Check that the LAN cable is connected.

Check that Standby Mode is set to Communication
On (or Network On) or Network Monitoring is set to
On in the projector's configuration menu.

See your User's Guide for more information.

Network error Check that the projector has been correctly
(ESC/VP.net connected to the network. See your User's Guide for
communication error) | more information.

Network error Check the projector's Monitor Password.
(Monitor Password
authentication error)

*  When the projector has 2 lamps, the additional information, such as (Lamp
1) or (Ballast 1), is displayed after the message so that you can know which
lamp has problems/warnings.

Messages to inform that the projector has recovered from the error or
warning statuses are sent.



Application lock function

Application lock function ) The password entry window will be displayed, so enter the

You can use the application lock to prevent third parties from operating " set password and then click "OK".
the projectors using EasyMP Monitor and from changing settings
without authority. Opening and closing EasyMP Monitor and status
monitoring can still be carried out even when the application lock is
applied.

If no password has been set (default setting), click OK without en-
tering a password. It is recommended that you enter a password in
order to strengthen security.

The application lock will be cancelled and operations can be carried

In addition, when a password has been set, the password must be entered out as normal.

in order to cancel the application lock. This ensures that the application
lock can not be easily cancelled, and thus improves system security.

Setting a password for cancelling application lock

Switching Application lock between enabled and Carry out the following operations while application lock is cancelled.
disabled

Procedure

§&\‘“‘WH””’%%
Enabling the application lock %@ Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.
Procedure e
) Select "Change the application lock password".
Select "Application lock" from the Tool menu.

The application lock will be enabled and no operations will be possible °/ Enter the password in both the "New password” and "New

other than opening and closing EasyMP Monitor and disabling the password (confirm)" boxes and then click "OK".

application lock. The password can be up to 16 bytes in length. Single-byte alphanu-
meric characters can be used.

Disabling the application lock

Procedure

Select "Application unlock" from the Tool menu.

—



Appendix



Troubleshooting

Troubleshooting

An e-mail message is not sent when a problem occurs
with a projector

Projectors cannot be monitored or controlled

Cause

Remedy

Cause

Remedy

Is the projector connected
to the network correctly?

Check that the network cable has been
connected correctly. If the cable is not
connected correctly, reconnect it.

Is the projector connected
to the network correctly?

Check that the network cable has been
connected correctly. If the cable is not
connected correctly, reconnect it.

Has the projector been set
up correctly for
connection to the
network?

Check the Network configuration settings.

See your User's Guide for more information.

Has the projector been set
up correctly for
connection to the
network?

Check the Network configuration settings.
See your User's Guide for more information.

Has EasyMP Monitor been
installed on the computer
correctly?

Uninstall EasyMP Monitor and then re-install
it.@ p.8

Have the SMTP server IP
address, Port Number and
Recipient mail address all
been set correctly?

Check the setting details.

Are all the projectors that
you want to control or
monitor registered?

Register the projectors. @ p.11

Is the projector's Standby
Mode set to
Communication On (or
Network On) or Network
Monitoring setto Oninthe
configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby
mode, the projector's Standby Mode must be
set to Communication On (or Network On) or
Network Monitoring must be set to On in the
configuration menu.

See your User's Guide for more information.

Is the projector's Standby
Mode set to
Communication On (or
Network On) or Network
Monitoring setto Oninthe
configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby
mode, the projector's Standby Mode must be
set to Communication On (or Network On) or
Network Monitoring must be set to On in the
configuration menu.

See your User's Guide for more information.

Has a critical problem
developed causing the
projector to momentarily
stop working?

When the projector has momentarily stopped
working, it cannot send e-mail messages. If the
projector cannot be reset even after it has
been checked, contact Epson. See your User's
Guide for more information.

Is power being supplied to
the projector?

Check if the power supply to the location
where the projector is set up has been
interrupted, or if the circuit breaker for the
electrical outlet that the projector is
connected to has been tripped.




Uninstalling EasyMP Monitor

Uninstalling EasyMP Monitor

To save or transfer the existing projector settings, make a copy of the
EMP Monitor.dat file before you uninstall the software.
@ "Transferring the settings" p.7

The following procedures to uninstall EasyMP Monitor vary depending
on your operating system.

e If your operating system is Windows 2000 or Windows XP

Click Start - (Settings) - Control Panel - Add/Remove Programs or
Add or Remove Programs to uninstall EasyMP Monitor.

e If your operating system is Windows Vista or Windows 7

Click Start - Control Panel - Uninstall a program to uninstall EasyMP
Monitor.

e If your operating system is Windows 8

From the Start menu, right-click "EasyMP Monitor Ver.x.x.xx" and
select "Uninstall” to uninstall EasyMP Monitor.

:@3 With Windows Vista, Windows 7, and Windows 8, settings and logs

’ remain on the hard disk even after EasyMP Monitor is uninstalled. If you
do not need this information, delete the EasyMP Monitor Ver. x.xx (Ver.
x.xx represents the version of the existing software) folder. This folder can
be found at "C:\Users\(User Name)\AppData\Local\VirtualStore\Program
Files\EPSON Projector” if the default settings were used to install the
software.



General Notice

General Notice

All rights reserved. No part of this publication may be reproduced, stored Trademarks

in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording, or otherwise, without
the prior written permission of Seiko Epson Corporation. No patent
liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the
use of the information contained herein.

Microsoft, Windows, Windows Vista, and the Windows logo are
trademarks of Microsoft Corporation in the United States of America
and other countries.

Macintosh is a registered trademark of Apple Computer, Inc.
Pentium is a registered trademark of Intel Corporation.

EPSON, EasyMP, and EasyMP.net are registered trademarks, and

Neither Seiko Epson Corporation nor its affiliates shall be liable to the EPSON Exceed Your Vision is a registered logomark of Seiko Epson
purchaser of this product or third parties for damages, losses, costs, or Corporation.

expenses incurred by the purchaser or third parties as a result of: Other product names used herein are also for identification purposes
accident, misuse, or abuse of this product or unauthorized modifications, only and may be trademarks of their respective owners. Epson disclaims
repairs, or alterations to this product, or (excluding the U.S.) failure to any and all rights in those marks.

strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or
problems arising from the use of any options or any consumable
products other than those designated as Original Epson Products or 3/13

Epson Approved Products by Seiko Epson Corporation. CPD-38875

©2013 Epson America, Inc.

This information is subject to change without notice.

Mlustrations in this guide and the actual projector may differ.
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